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Introduction

Infor CRM is a leading customer relationship management solution that enables small to medium-sized businesses to
acquire, retain, and develop profitable customer relationships through integrated Sales, Marketing, Customer Service,
and Support automation solutions.

Saleslogix is now Infor CRM. Look for the new branding in this release and future releases.

All references to the CRM Core product, CRM Clients, Web Client, Windows Client, Administrator, and database refer to
Saleslogix versions between 8.0 and 8.1 update 03 unless otherwise specified.

Why Use Infor CRM?
The Infor CRMWindows Client helps you manage all aspects of the sales cycle and the customer relationship. In
addition to tracking contacts, accounts, opportunities, tickets, and activities, users have access to tools for reporting,
automating processes, and creating e-mails, faxes, and letters using mail merge.

Key Features
The following key features describe how you can use the Infor CRMWindows Client:

Contact, Account, and Opportunity Views - Use the Contact, Account, and Opportunity views to manage detailed
information about your contacts, accounts, and opportunities.

Calendar and Activities - Use the Calendar to view open and completed activities and events. Use the Activities view to
manage such daily activities as scheduling phone calls, meetings, and events.

Lookups - Use lookups to search for records or build groups. Lookups enable you to filter your record list, and then save
the results as a new group. Lookup options vary by record type.

Groups - Use groups to organize your contacts, accounts, opportunities, tickets, and other data based on common
characteristics. Groups can be used for reporting, mail merges, and more.

Campaigns and Leads - Use Leads to develop and qualify new Contacts and Accounts. Use the Campaign functions to
combine advertising, public relations, sales promotion, and selling activities to achieve sales or marketing goals.

Mail Merge - Use Mail Merge when you need to communicate with a group of contacts, accounts, opportunities, or leads.

Reports and Analysis - Use Reports and filters to summarize information about your contacts, accounts, opportunities,
contracts, and tickets. The Infor CRM Dashboard view allows you to display performance and analysis information in a
dashboard format.



Customer Service and Support - Use tickets to track, qualify, and resolve customer questions and issues. You can track
time spent working on a ticket through Punch in/Punch out, create ticket activities that are charged against the
customer’s service contract, and schedule calendar activities. The Service and Support features also provide a means of
tracking defects in products or services, and include a return process.

Literature Requests - Use literature requests to schedule sending marketing material or other documents to contacts.
Literature requests are generally paper materials that must be mailed.

Library - Use the Library as a central repository for your company information. The Library often contains items such as
product information, sales literature, and presentations.

Processes - Use processes to execute a series of tasks in a specific sequence over a set time period. The Infor CRM
Windows Client offers Sales Processes and Contact Processes.

Advanced Outlook Integration - Use Advanced Outlook Integration to access Microsoft Outlook when sending e-mail,
scheduling activities, and managing contacts. This feature must be enabled by your system administrator.

Onsite and Remote Access - Use Infor CRM in your office or from a remote location.

About This Guide
The purpose of this guide is to help you begin using the Infor CRMWindows Client. This guide uses scenarios to
demonstrate how to use the Infor CRMWindows Client for many of your daily tasks.

You can access Infor CRM on a network (while in the office) and remotely (from a laptop). The procedures described in
each chapter are the same when you are using the Infor CRMWindows Client in the office or working remotely.

If your company has customized the Infor CRMWindows Client, the number, order, and appearance of dialog boxes and
screens may be different than described. See your system administrator for more information.

The Help symbol precedes online Help topic names where you can find additional
information.

Related Documentation
n Infor CRM Quick Reference cards provide commonly used shortcut keys, e-mail configuration options, and tips for

working with groups and Outlook Integration. The Infor CRM Quick Reference cards are accessible from the Start
menu. Click Start, point to Programs, point to Saleslogix, point to Documentation, and then click Customer Service
and Support User Quick Reference or Sales and Marketing User Quick Reference.

n The Infor CRM Client Help provides detailed information about all of the features available in the Infor CRM Client,
including additional information about Send to CRM and Mail Merge.

n The Infor CRM Mail Merge Help provides detailed information on the following: writing an e-mail message to a
contact, writing an e-mail message, letter, or fax using a template, and using the Mail Merge engine to send
correspondence to a group of contacts, accounts, etc. This help system also explains how to create and print
address labels or envelopes, as well as, how to create, edit, and delete templates.

Help is available in each Infor CRM application. Additional resources and documentation are available to Partners and
Customers with a valid technical support contract at www.infor.com/inforxtreme.
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Introduction

Contacting Infor
If you have questions about Infor products, go to the Infor Xtreme Support portal at www.infor.com/inforxtreme.

If we update this document after the product release, we will post the new version on this website. We recommend that
you check this website periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.

http://www.infor.com/inforxtreme
mailto:documentation@inform.com
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Chapter 1
Understanding the Infor CRMWindows Client
Workspace

Take a few minutes to learn some of the Infor CRMWindows Client basics. It will help you become familiar with the
workspace and navigation features.

In this chapter, you will learn to:

n Log on to the Infor CRMWindows Client

n Understand the Infor CRMWindows Client workspace

n Get more help

Signing in to the Infor CRM Windows Client
Before you begin, locate your User ID and password. If you do not have this information, contact your system
administrator.

If a database connection was not configured during your installation, you must
create a new connection. See the "Logging on to the Infor CRM Client" Help topic
for detailed instructions.

To log on

1. Click Start, point to Programs, point to Saleslogix, and then click Saleslogix Client.

2. Type your Username and Password.
Passwords are case-sensitive. In addition, your system administrator may set restrictions on using blank
passwords, your user name as a password, and other options. If necessary, see your system administrator to
discuss your password options.

3. In the Log on to box, select the database you want to use from the list.
Your company may have more than one database. Be sure to select the correct database for the work you intend
to do.

4. Click OK.
The Activity Reminder appears when you have overdue activities, or if you need to confirm any activities. You
can act on the listed activities, snooze them individually or as a group, or just close the reminder.

Getting Started with Infor CRM | 5
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Working in the Infor CRM Windows Client
The workspace is the area where various views appear in the main Infor CRMWindows Client.

Figure 1 Infor CRMWindows Client Workspace

Understanding theWorkspace Features
Each view in your Infor CRMWindows Client contains many of the following elements.

Your workspace may be different depending on your access rights or if your
installation has been customized.

Element Description
Title Bar The title identifies the active view. When you are in a detail view, the title bar

displays the name of the current record.

Standard Toolbar Also called the toolbar, the Standard toolbar contains buttons that you click to
open the most frequently used Infor CRM commands. To move the toolbar,
drag it to another part of the window. From the View menu, you can show or
hide toolbars.

Chapter 1 Understanding the Infor CRMWindows Client Workspace
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Element Description
Navigation Bar Located on the left side of the Infor CRMWindows Client workspace, the

Navigation Bar contains buttons that open the main Infor CRMWindows
Client views.

Your administrator can group the buttons into Navigation Group subsets that
focus on specific elements of your business, such as Sales or Support. For
example, the Support group contains Contacts, Tickets, Defects, Activities,
Calendar, and Reports.

Menu Bar The menu bar contains the Infor CRMWindows Client commands. Click a
menu to expand it.

Each menu item has an access key, which is the underlined letter in the item
name. For example, to insert a new contact or account, you can open the
Insert menu, then press C. Shortcut keys also appear to the right of some
menu items; you can press these keys to activate the feature. For example, to
schedule a phone call, press SHIFT + F3. For Windows 7 users, you must
press the Alt key to see the underlined access letter.

Speed Search SpeedSearch helps you find information stored in the Infor CRM database.
For example, you can search through existing tickets or procedures to help
solve a customer's problem, or search for a specific document, like a sales
presentation.

Quick Find The Quick Find button, located in the upper left corner of the view can be
used to search for a particular contact, account, opportunity, ticket, lead,
campaign, defect, contract, or return.

Previous/Next Buttons located on the toolbar that allow you to view a previous or next
contact, account, or opportunity. These buttons become active when you
have viewed more than one contact, account, or opportunity during a single
Infor CRM Client session.

Group Button Located opposite the Quick Find, third from the right on list and detail views,
displays a tree view of all groups. You can double-click a group in the tree
view to open that group.

Group Options Located second from right on the on the list and detail views, click the Group
Options button to display a menu of options of all groups.

Tabs Tabs organize information on many of the list views, detail views and dialog
boxes.

Tree Views Tree views are lists of items organized into categories. Click to expand or
collapse the tree view.

Pick Lists A pick list is a set of values you can select from when entering data. Pick lists
are useful because they encourage consistent data entry. Your access rights
determine if you can add, edit, or delete pick list items. To open a pick list,
click the ellipsis button in the box. You may need to click once in the box
before the ellipsis button appears.

Lookup Labels Detail views contain pre-defined label lookups. When you rest your mouse
pointer on a label, it becomes a button that you can click to perform a lookup.

Shortcut Menus Right-click in many Infor CRM views to get a menu of features available for
that area.

F8 Use F8 to switch between the Split view open or closed.



Element Description
Shift F9 Use Shift + F9 in some memo fields to insert a Name/Date/Time stamp in a

text box.

Status Bar The status bar displays the current date, user, database, and status icons,
such as whether or not you are logged in to e-mail. Right-click an icon to
open a shortcut menu. You can show or hide the status bar by opening the
View menu and clicking Status Bar.

Using List Views

List views display information in a list with columns and rows of information. Press F8 from any detail view to display the
corresponding list view. Each tab in the list view contains a group of contacts, accounts, opportunities, or tickets and so
on.

n You can customize the List view by sorting information in the columns, rearranging the order of columns, and
adjusting column widths.

For more information, see the "Columns" topic in the Sales Client help.

n You can right-click in a List view to open the shortcut menu for options such as adding and deleting group members

Figure 2 Account List View

n You can customize the List view by sorting information in the columns, rearranging the order of columns, and
adjusting column widths.

For more information, see the "Columns" topic in the Sales Client help.

Chapter 1 Understanding the Infor CRMWindows Client Workspace
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n You can right-click in a List view to open the shortcut menu for options such as adding and deleting group members

Figure 3 Account List View



Using Detail Views

Most records in Infor CRM display information in both a List view and a Detail view. The Detail view consists of
information boxes, tabs, and a user-defined middle section.

n The upper section shows basic information about the selected record. When you add a new record, dialog boxes
guide you through entering the information that appears in the Detail view. To edit information, click the box you
want to change.

n The middle section is called the user-defined area. You can use this area to keep the tab you use most often
visible. To move a tab to the middle section, click one of the tabs in the bottom section, hold the mouse button, and
drag the tab to this area. The tab will remain open in the user-defined area each time you use the Infor CRM
Windows Client. If you want to change the tab in the middle section, select another tab and drag it to replace the
current tab.

n The lower section contains a group of tabs. Each tab shows specific information you need for the related record.
Your system administrator can create custom tabs for your company.

Figure 4 Account Detail View

Chapter 1 Understanding the Infor CRMWindows Client Workspace
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Using Split Views

Split views display information from both the Detail view and the List view. Using the Split view, you can click the account
in the List view section of the screen and display its detail information in the other section of the screen. If you often
switch between accounts, use the Split view to manage your information.

n Use Ctr + F8 to switch between the Split view open or closed.

Figure 5 Account Split View

Getting Help
Information on advanced features and areas not covered in this guide is available in the Infor CRMWindows Client
online Help topics.

To access online Help, do one of the following:

n Click the Help button on any screen in the Infor CRMWindows Client or if a Help button is not available, press F1.

n On the Helpmenu, click Help Topics.

What do you want to do? Topic Name
Find out what new features have been added to the
Infor CRMWindows Client.

What’s New in This Release

Customize the Infor CRMWindows Client options for
my personal needs.

Setting User Preferences

Access a graphic display of business process
performance to perform in-depth data analysis

Displaying the Sales Dashboard

Schedule a meeting and invite others. Scheduling or Editing an Activity

Schedule an Event (such as a trade show). Scheduling or Editing an Event

Use the Activity Reminder Activity Reminder



In addition to the Help, you can find more information from the following sources:

System Administrator See your system administrator for answers specific to your Infor CRM installation.

Configuring Outlook Integration

Outlook integration preferences should be configured in Microsoft Outlook.

Before you can configure Outlook:

n Microsoft Outlook must be installed and running on the local machine.

n Web - Desktop Integration will not install unless Microsoft Office, including Outlook, is already installed.

n Windows - If Microsoft Outlook was not installed before installing the Infor CRM Client, you must perform
additional configuration steps. For more information, see the topic "Configuring Outlook if not Installed Prior
to Installing Infor CRM" in the Infor CRM Client Help.

n You must know the connection server and port number and your user name and password.
Contact your system administrator for more information.

To configure

1. Open Microsoft Outlook.

2. If you are not prompted, click the Options button.
If the Options button does not appear, then Outlook sync has not been installed properly.

3. Use the tabs to set the following options:

n Connection - connection to the Infor CRM server. Required for contact and calendar synchronization and
e-mail integration.

n Send to CRM/Record to History - options for prompts,displaying information, and attachment behavior
when using Send to CRM or Record to History.Used for e-mail integration.

n All Options - ability to view options as value pairs. Recommended for advanced users only.
For more information see the Outlook Sync help topic "Configuring Outlook Sync".

4. Click OK.

Chapter 1 Understanding the Infor CRMWindows Client Workspace
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Chapter 2
Managing Contacts and Accounts

This chapter introduces you to the core of Customer Relationship Management (CRM) - working with contacts and
accounts.

n Contacts are the key people associated with an account.

n Accounts are your prospects and customers. Accounts can contain one or many contacts.

You can use Infor CRM to manage contact and account information. This includes daily interactions, such as phone
calls, meetings, action items, or other correspondence.

In this chapter, you will learn to:

n Add a contact and an account

n Create an account association

n Use the Library

n Schedule a literature request

n Add a note and schedule a follow-up activity

Adding a Contact and Account
Infor CRM focuses on account relationships. Therefore, all contacts must be attached to an account. Account and contact
information is accessible by any Infor CRM user who has the appropriate security. For example, you can create an
account for Beeker Motors. Your Sales Assistant may not have the required security to access the account, but your
Sales Manager can.

You cannot create personal accounts or contacts in Infor CRM unless your system administrator enables this option for
you. Personal contacts would include people such as your spouse or dentist.

Understanding Account Ownership
Before creating an account in Infor, it is important to understand account ownership.

n The Account Owner has access to an account and can use any account-related activities such as scheduling
activities and running reports. An account owner can be an individual user, a team, or all Infor CRM users.
Access to account data can be different for each user. For example, if a team owns an account, some team
members may have read-only access to the account, while others have read/write access. Security is controlled by
your system administrator.

n The Account Manager is responsible for managing the relationship with the account. This can include follow-up
phone calls, meetings, preparing proposals, and working with the account’s contacts. The account manager is a
single individual.

Getting Started with Infor CRM | 13
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The individual user designated as the account owner is often also set as the account manager. If a team is the account
owner, a team member will usually be set as the account manager. Account owners and managers should be assigned
according to your company’s guidelines.

There are several ways to add contacts and accounts to Infor CRM. This guide will explain the most common methods.

Our scenario:
You met Tom Dale and Joan Smith at a trade show. Tom and Joan (contacts) work for Beeker Motors (account).
First you will add contact Tom Dale to a new account (Beeker Motors); then you will add Joan Smith to an existing
account (Beeker Motors).

Chapter 2 Managing Contacts and Accounts
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To add contacts and an account

1. On the Insert menu, click Contact/Account.

2. In the Add Contact/Account Information dialog box, select New Contact and New Account, and then click
Next.

3. In the Contact box, type Tom Dale.
To add hyphenated last names or names with a professional designation, click the ellipsis button in the Contact
box. Then use the Enter Name dialog box to specify a name prefix (such as Dr.), first name, middle name, last
name, or suffix (such as C.P.A).

4. In the Account box, type Beeker Motors.

5. In the E-mail andWeb boxes, add e-mail and Web address information.

n E-mail - tom.dale@beeker.mail

n Web:www.beeker.web

6. In theWork Phone field, type 5551234512.

7. Click the Look for Matching Records button.
This searches the database for records that have the same e-mail address, Web address, phone number, and
account. It is important to search for records before adding information. If you do not check for existing
information, you might create a duplicate contact or account.

8. Click OK to close the NoMatches dialog box, or click Cancel to close the Matching Records dialog box.

9. In the Contact Information area, in the Title box, click the ellipsis button and select Vice President.

10. Continue to add Tom’s information in the Contact Information section.

11. Under Account Information, double-click in the Address box to open the Edit Address dialog box and add the
Address information for Beeker Motors, as follows:

n Leave Description as Office.

n In the Address 1 box type 1234 Gary Parkway

n In City, State/Prov, Zip/Postal type Oak Park, IL 60305

12. Click OK.

13. In the Main box type 5551234500.

14. Click the Type ellipsis button and select Customer.

15. Click the Status ellipsis button and select Active.

16. Click the Industry ellipsis button and select Automotive/Aerospace.

17. In the Acct. Mgr. box, click the Find button, and then select the account manager.

18. In the Owner box, click the Find button, and then select an owner.

19. In the Lead Source box, click the Find button, select Trade Show and then click OK.

20. Click the Save & New button.
This option allows you to add another contact to the existing account.

21. In the Contact box, type Joan Smith.

22. In the E-mail andWork Phone boxes, add e-mail and Work Phone information.

n E-mail - joan.smith@beeker.mail

n Work Phone - 5551234519



23. In the Contact Information area, in the Title box, click the ellipsis button and selectManaging Director.

24. Click OK.

For more information see the "Adding a New Contact and Account" topic in the
Infor CRMWindows Client Help.

If you need to edit a contact or account’s information, you can do so by clicking the boxes on the Detail view and typing
in the changes.

You must click the Save button after making any changes.

Adding an Account Association
Accounts may have a common connection, for example, one company may be a parent of another. You can create a
relationship between accounts by adding an association. This association can be helpful for tasks like running reports.
You can create one report for both accounts rather than two separate reports. Associations can also create opportunities
for you to sell to parent companies rather than subsidiaries.

Our scenario:
Tom Dale told you that Beeker Motors was owned by International Machines. You want to create a
parent/subsidiary relationship between the two accounts.

To associate accounts

1. Open the Beeker Motors Account Detail view.

a. On the Navigation Bar, click Accounts.

b. Click the Accounts Quick Find button (magnifying glass).

c. In the Find box, type be, and then click the Find button

d. In the list, click Beeker Motors.

2. On the Beeker Motors Account Detail view, click the Associations tab. If the tab is not visible, click the More
Tabs tab.

3. Right-click in the tab view, and then select Associate Account.

4. In the Account box, type Int, and then click the Find button.

5. Click International Machines in the account list, and then click OK.

6. Click the ellipsis button below Beeker Motors is a and select Subsidiary.

7. Click the ellipsis button below International Machines is a and select Parent.

8. In the Description boxes, type a description for each account.

9. Click OK.

Working with the Library
The Library is a central repository for company information. Files are organized into folders and sorted by name. Click
the column headings to sort the library files list.

Your company’s library may include product information, policies and procedures, presentations, Web addresses, and
so forth. Only the administrator and an administrative user can add files to the Library.

Chapter 2 Managing Contacts and Accounts
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n If you are using Infor CRM on a network, you can access a file directly from the Library without storing the file on
your computer.

n Infor CRM Remote users must request files from the Library. When Remote users synchronize, the request is sent
to the server and the requested file is delivers during the synchronization.

Our scenario:
You want to use the Library to find current product information.

To access information from the Library

1. On the Navigation Bar, click Library.

2. In the tree view, click the "+" signs to expand the folder that contains the file you want to open.

3. Double-click the file to open.

For more information see the "Working with the Library" topic in the Infor CRM
Windows Client Help.

Requesting Literature for a Contact
Literature requests involve sending marketing materials or other company documents to one or more contacts. Infor
CRM users or the system administrator manage the available literature. After you schedule a request, the person or
group at your company responsible for literature fulfillment can fulfill and complete the request.

If you are making the request for a single contact, select the contact before you begin the following steps.

Our scenario:
Joan Smith requested information on a specific product at a trade show, but you had run out of brochures. You
want to schedule a literature request to send the information to Joan.

To schedule

1. Open Joan Smith’s Contact Detail view.

a. On the Navigation Bar, click Contacts.

b. Click the List/Detail button.

c. Click the Latest Contacts group tab.

d. In the list, double-click Smith, Joan.

2. On the Schedule menu, click Literature Request.

3. In the Description box, enter a brief description of the literature request.

n Type Lenovo ThinkPad sales brochure.

4. Click the Send by Calendar button, select a date, and then click OK.

5. In the Send via (delivery method), and Priority boxes, click the ellipsis button, select FedEx and Medium.

6. In the Cover box, click the folder button, choose the appropriate cover letter or memo from the list, and then click
OK.

7. In the Request for area, make sure the option of Current Contact (Smith, Joan) is selected.

8. Under Print literature list, selectwith cover letter.



9. In the Available Literature area, select the items you want to include in your request.

a. Expand Hardware.

b. Select Lenovo ThinkPad Brochure.

c. Double-click the document to set the quantity for each. Use the default of 1 or type a number, and then click
OK.

10. Click OK.

The literature request is recorded on the Literature in the Activities view and on the Literature Requests tabs in the
Contact and Account Detail views.

The person assigned by the administrator to monitor Literature Requests will receive your request and should fulfill it by
the date you specified.

Scheduling a Follow-up Activity
In Infor CRM, phone calls, meetings, to-dos, and personal appointments are called activities. Scheduling follow-up
activities can help you organize and remember important events.

Our scenario:
You want to schedule a phone call to follow-up on literature that was sent to Joan Smith.

To schedule a phone call

1. Open Joan Smith’s Contact Detail view.

2. On the Schedule menu, click Phone Call.

a. If prompted, in the Lookup box, select Smith, Joan, and then click OK.

b. If prompted, in the Regarding box, select Confirm Literature Received, and then click OK.

3. In the Start Time box, click the Calendar button to select the date and time when the activity will occur, and then
click OK.

4. Do one of the following:

n Select the Timeless check box to create an activity that occurs on a specific date, but at no specific time
and without a specific duration.
Timeless activities are displayed on the Calendar day view.

n In the Duration boxes, set the expected length of time for the activity.

5. Select the Alarm check box to set an alarm to notify you before the activity begins. Use the drop-down boxes to
select the number of minutes, hours, or days. You must enter an increment between 1 and 240.

6. Verify the Name and Account boxes contain Joan Smith and Beeker Motors.
If any information is incorrect, click the Find button to change the information.

7. If you have not selected an item for the Regarding box, click the ellipsis button and select Confirm Literature
Received.

8. In the Notes box, type Follow-up call for Joan Smith’s literature request.

9. Click OK.

You can view the scheduled phone call in the Contact and Account Detail views (on the Activities tab), in the Activities
view (on the All Open and My Activities tabs), and in the Calendar view. If your company uses Advanced Outlook
Integration, the activity is scheduled in your Outlook calendar.
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For more information see the "Scheduling or Editing an Activity" topic in the Infor CRMWindows Client
Help.

Adding a Note
You use notes to document the outcome of an activity and to record interactions with an account, contact, lead, or
opportunity. The notes you add appear in the Notes/History tab on the Account, Contact, Lead, and Opportunity Detail
views.

There are several ways to add a note. One method was chosen for the example below.

Our scenario:
You found Tom Dale’s business card while cleaning out your briefcase. You had a note on the back indicating Tom
was interested in a support contract for any products his company purchased. You want to add this information to
Infor CRM.

To add a note

1. Open Tom Dale’s Contact Detail view.

2. On the Insert menu, click Note.

3. If necessary, modify the Completed and Scheduled dates. Click the Calendar button, select a date, and then
click OK.

4. If you need to enter a duration for the note, clear Timeless, and then select or enter a Duration.

5. Verify the Name is Tom Dale and the Account is Beeker Motors.

6. In the Regarding box, type Business card notes.

7. In the Location box, type 2012 Trade Show.

8. In the Notes box, type the information on the business card.

9. In the Priority box, click the ellipsis button and select an item from the list.

10. In the Category box, click the ellipsis button and select an item from the list.

11. Verify that your name is in the Leader box.

12. If necessary, click the Attachments tab to add a document or URL.

13. Use the Carry Over Notes or Carry Over Attachments check boxes to copy notes or attachments from this note
to the follow-up activity.

14. Click the To-Do button.

15. In the Schedule To-Do dialog box, schedule an activity for today.

a. For the Regarding type Research.

b. In the Notes type, Research a support contract for Beeker Motors.

c. Click OK to schedule the activity.

16. After scheduling the to-do, click OK to save the note.

You can view notes on the Notes/History tab of the Contact, Account, Lead, and Opportunity Detail views. In addition, the
Notes/History tab allows you to view and filter notes and other history items.

For more information see the "Adding a Note" topic in the Infor CRMWindows Client
Help.
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Chapter 3
Managing Your Sales Activities

Infor CRM can help you manage your daily activities, whether they are scheduled or unscheduled. Scheduled activities
include phone calls, meetings, to-dos, and appointments. Unscheduled activities, such as returning a phone call or
answering e-mail, may occur several times a day.

In this chapter, you will learn to:

n Use Activity Reminder

n Complete an unscheduled activity and schedule a meeting

n Use the Calendar and Activities views

n View the history of an account

Using Activities and Events
Activities and Events provide a way to stay on top of your work responsibilities.

n Events usually span several days and might include trade shows, business trips and conferences.

n Activities include placing phone calls, attending meetings, and to do's, such as sending correspondence or
preparing presentations.

n Activities can be associated with contacts, accounts, leads, opportunities, or tickets. Activities are generally
scheduled for a specific time, but can also be scheduled as "timeless" activities. Completed activities become
history items.

n You can schedule activities during an event, such as setting up various appointments and meetings for a business
trip.

When you schedule an activity, it displays on the Calendar, Activities view, and in the Activities tabs on the Account,
Contact, Opportunity, Lead, and Ticket views. Events display on the Activities view, Events tab and Calendar as well.
The Infor CRMWindows Client includes an Activity Reminder feature that alerts you to overdue activities and new
activities that you have yet to confirm.

Several activity types are available to accommodate your work requirements. For instance, you can create general
activities, recurring activities and more. In general, you can edit, delete, or complete activities and events that you create.

Activity Reminder
The Activity Reminder helps you keep track of any activities (scheduled, timeless, unconfirmed, or recurring) that have a
reminder setting. When any of your activities are overdue or if you need to confirm any activities, the Activity Reminder
will display. When the Activity Reminder displays, you can choose to act on the listed activities, or be reminded of the
activities at a later time.
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Closing the Activity Reminder snoozes all of the alarms and activity reminders in the
Activity Reminder window.

Current activities are listed first, followed by past due activities in red text, and finally unconfirmed activities in bold. To
display past due activities that do not have alarms set, select the Display Past Due check box. Notes for the activity
selected in the grid appear in the Notes box below the activities list.

Using the Activity Reminder buttons

Select an activity, and then use these buttons:

Button Description
Open Opens the Schedule activity window. If the selected activity is unconfirmed, the

Confirmation dialog will open.

Complete Opens the Complete Activity dialog.

Go To Presents a list of associated detail views for the selected activity, and opens the
selected view. Depending on the activity type, the list may include Account, Contact,
Lead, Opportunity, or Ticket views.

Reschedule Opens a Reschedule Activity dialog, allowing the activity leader (creator) to
reschedule an activity or a group of activities.

Dismiss Turns off the alarm for the selected activity or activities. The activity remains on the
Activities list view, but the alarm is reset to 'off'. (Not the same as Snooze, which
temporarily disables the alarm.)

Help Opens the Help topic for the Activity Reminder.

Snooze Removes the selected activities from the reminder window for the amount of time
selected in the Snooze by: box.

Snooze All Closes the reminder window (Snoozes all of the activities) for the amount of time
selected in the Snooze by: box.

Completing an Unscheduled Activity
Unscheduled activities can occur unexpectedly throughout the day. It is a good idea to keep Infor CRM open at all times
so you can quickly access contact and account information. After you respond to an unscheduled activity, you should
complete the activity in Infor CRM to create a record of the interaction with the contact or account.

When you complete an activity, details about it are recorded on the Notes/History tab for the related account, contact,
opportunity, or lead.

Our scenario:
You received an unexpected call from Tom Dale about a sales opportunity. You need to complete an activity for the
unscheduled phone call and schedule a follow-up meeting.

There are several ways to complete an activity in Infor CRM. The following method allows you to complete the activity,
schedule a follow-up meeting, and carry over the notes.

To complete an unscheduled activity

1. Open Tom Dale’s Contact Detail view.

2. On the Schedule menu, select Complete Activity.

3. Select Phone Call, and then click OK.
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4. The Completed and Scheduled boxes automatically show the current date and time. You can accept the default,
or select a new date and time.

5. In the Regarding box, click the ellipsis button and select Discuss Opportunities from the list.

6. In the Notes box, type Tom Dale called about a possible sales opportunity.

7. To schedule a follow-up activity

a. Select Carry Over Notes to include your notes in the follow-up activity.

b. Click the Meeting button.

8. In the Schedule Meeting dialog box, verify that the Notes field includes the notes from the phone call.

9. Select a date and time for the meeting, and then click OK to schedule the follow-up meeting

10. Click OK to complete the phone call.

For more information see the "Completing an Activity" topic in the Infor CRM
Windows Client Help.



Inviting Others to a Meeting
When you schedule or edit a meeting or a phone call in the Infor CRMWindows Client, you can include other Infor CRM
users in the activity. These types of appointments appear on the Confirmations tab in your Activities view. You can
accept or decline activities listed on the Confirmations tab.

If you company uses Advanced Outlook Integration, you can include non-Infor CRM
users in the activity. The Microsoft Outlook Attendee Availability tab appears instead
of the Members and Resources tabs.

Our scenario:
You want to invite a co-worker (from your company) to your meeting with Tom Dale (a contact for Beeker Motors).

To invite others to a meeting

1. Open Tom Dale’s Contact Detail view.

2. Click the Activities tab.

3. In the list, open the meeting you scheduled in the previous scenario.

4. Click the Members tab.

5. In the Available Members list, select a user, and then click Add.
If you are using Advanced Outlook Integration, click Invite Others and select a user from the Outlook Address list.

6. Click OK.

The other user wil receive an Activity Reminder to confirm the activity. If the other user uses Infor CRM on a network with
Advanced Outlook Integration, he or she will receive an Outlook e-mail message to accept or decline the meeting. After
the user confirms or declines the meeting, you will receive a confirmation of the response.

For more information see the "Scheduling or Editing an Activity " topic in the Infor
CRMWindows Client Help.
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Using the Calendar
Use the Calendar to manage your time and keep track of scheduled activities and events. The Infor CRM Calendar
displays both open and completed activities and events, depending on your calendar options.You can view your
schedule by the day, week, month, or year view. Use the calendar right-click menu to schedule, edit, complete, or delete
activities and events.

Your calendar security determines whose activities you can schedule, view, edit, complete or delete.

Depending on your access rights, you can view the calendars and activities of other Infor CRM users. You can assign
specific colors to each user to help you to determine which activities belong to which users. If an activity is scheduled for
multiple users and you are the leader or member, it will display your color. If you are not an activity member or leader,
then the activity leader's color will be displayed.

If your company uses Microsoft Outlook, you can view your Outlook calendar in Infor
CRM instead of the Infor CRM calendar. To select this option, on the Tools menu,
click Options, click the Calendar tab and under Show this calendar, select Outlook.

Some icons may not appear in week and month views due to limited space.

Our scenario:
You want to check your calendar to see if you have time available to meet with your co-worker before the meeting
with Tom Dale.

To view the calendar

1. On the Navigation Bar, click Calendar.

2. Select the type of calendar to view.

n Day View - Displays a timeline for the day. Lists all scheduled activities and events for that day.

n Week View - Displays each day in the selected week. Lists scheduled activities and events for each day.

n Month View - Displays month calendar, listing scheduled activities for each day.

n Year View - Displays a 12-month calendar and a list of events and activities scheduled for selected dates.
Bold numbers on the calendar indicate dates with scheduled activities.

3. To customize the types of activities you see in the calendar, right-click in the calendar, and on the shortcut menu,
point to Show, and then select all of the activity types that you want to appear on the calendar.

4. To view the other user's calendar

a. Click the User button (your name) in the top right corner.

b. In the Select Users to View dialog box, click Add, select the other user you want to view, and then click OK.

c. Click OK.

5. To print the calendar, on the File menu click Print Calendar Reports, select your options, and then click Print.

For more information see the "Using the Calendar" topic in the Infor CRMWindows
Client Help.



Using the Activities View
Use the Activities view to manage your scheduled activities, events, literature requests, and confirmations. If you have
additional access rights, you can also view other Infor CRM users' activities.

The tabs that appear in the Activities view are:

All Open To-Dos Events

Calls Personal Literature

Meetings Alarms Confirmations

The following icons provide information about the activity:

Icon Description
Phone Call

Meeting

To-Do

Personal Activity

The activity has an attachment

The activity is a single occurrence of a recurring activity

The activity has an alarm

Our scenario:
You want to see how many phone calls you have tomorrow.

Open the Activity List view

To view phone calls scheduled for tomorrow

1. On the Navigation Bar, click Activities.

2. Click the Calls tab.

3. Click the drop-down arrow and select Tomorrow from the list.
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Viewing a History of Interactions with an Account
When responding to scheduled or unscheduled activities, you may need to view the history of interactions with the
contact and account or lead. For example, if a customer calls to ask a question she had from your last meeting, you can
open the account history to view the meeting notes. The Notes/History tab contains all interactions, including full text
notes, and provides filter options for viewing, e-mailing, and printing history items and notes.

If the Show history for all participants option is not selected, then you will see a
history item for only the primary participant.

Our scenario:
You want to review all the interactions you have had with anyone at Beeker Motor’s.

To view account history

1. Go to Beeker Motors’ Account Detail view.

2. Click the Notes/History tab. If the tab is not visible, click the More Tabs tab.

3. If necessary, click the FilterOptions button and use the filters to narrow the list of history items.

4. Right-click the item with the history item to be viewed, and then click View History.

5. When you are finished viewing, click Close.

For more information see the "Notes/History Tab" topic in the Infor CRMWindows
Client Help.
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Chapter 4
Communicating with Contacts and Leads

In addition to telephone calls and meetings, you may need to send additional information to your contacts or leads, such
as proposals, letters, or memos. Through the Infor CRMWrite menu, you can create and edit templates, letters, and other
business correspondence. You can then use Mail Merge to merge your template to contacts, leads, accounts, or
opportunities.

Outlook Integration with Infor CRM enables you to share information between Microsoft Outlook and Infor CRM when
you write e-mail messages, add contacts, and schedule meetings.

In this chapter, you will learn to:

n Set your e-mail system options

n Create a template

n Use Mail Merge to send information to contacts

n Work with Microsoft Outlook e-mail

Setting E-mail Options
Before you can use e-mail in Infor CRM, you must first set your e-mail options. Use the E-mail tab in the Infor CRM
Options dialog box to set up your e-mail application options. Depending on the e-mail application you select, some
options will not be available. Your administrator determines which options are available for you to set and can override
any changes you make to the e-mail settings. If you notice that your settings have changed, contact your system
administrator.

Use the following steps to set up your e-mail options to use Microsoft Outlook as your mail system.

To set e-mail system options for Microsoft Outlook

1. On the Infor CRM Client Tools menu, click Options, or, right-click in any calendar view, and then click Options.

2. Click the E-mail tab.

3. In the Mail System Options area, in the Mail System box, selectMicrosoft Exchange or Microsoft Outlook.
Microsoft Outlook users: If your company is using the Advanced Outlook Integration feature, you should select
Microsoft Outlook as your e-mail system.

4. In Profile Name box, select from the list of available local profiles.

5. To connect to the e-mail application when you start the Infor CRM Client, select Automatically Logon to e-mail.

6. If you connect through the Internet via POP3/SMTP or IMAP4/SMTP, select Automatically dial using, and then
select from the list.

n Network users: click None.

n Remote users: click your dial-up networking connection name.
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7. In the Log to History area, select one of the following options:

n If you select Prompt, when you use the Send button in Outlook, no prompt appears, the e-mail is not
recorded to History.

n If you select Prompt, when you use the Send to CRM button in Outlook, the Complete E-mail dialog box
opens so you can edit the details of the history item and schedule a follow-up activity.

n If you select Do Not Prompt, when you use the Send button in Outlook, no prompt appears, and the e-
mail is not recorded to History.

n If you select Do Not Prompt, when you use the Send to CRM button in Outlook, no prompt appears, and
the e-mail is recorded to History.

8. In the Record E-Mail to History area, select Prompt for Duplicate Contacts and/or Prompt for Contact not
Found.
These prompts are message boxes informing you of a problem when logging the e-mail message to a contact's
History.

9. Click OK.

For more information see the "Setting E-mail Options" topic in the Infor CRM
Windows Client Help.

Working with Templates
You can use templates to create letters, proposals, faxes, or e-mail messages that will be used for more than one contact
or lead. Templates use standard text that does not change, as well as mail merge fields that use Infor CRM information
that changes depending upon the contact or lead being merged. Infor CRM has two types of templates:

n Public templates are created and distributed by the system administrator and stored in the Public Templates folder.
Public templates usually are released to all users. When you copy a public template and save it to your computer, it
becomes a private template.

n Private templates are created by a user and are automatically stored in the Private templates folder. When you
create a private template, only you have access to the template.

Templates are created using Microsoft Word, so you must have Microsoft Word installed on your local machine for
template creation.

For more information see the "Managing and Selecting Templates" topic in the Infor
CRMWindows Client Help.
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Creating a NewTemplate
These instructions help you create a new private Microsoft Word template.

Our scenario:
Tom Dale requested a pricing proposal for 150 motors. You need to create a new pricing proposal template.

To create a new template

1. On theWrite menu, select Templates.

2. In the Manage Templates dialog box, click New.

3. In the Properties for: NewWord Template dialog box, do the following:

a. In the Template Type section, select E-mail.

b. In the Name box, type Pricing Proposal.

c. In the Family box, select E-mail.

d. In the Main Table box, select Contact.

e. In the Owner box, your name should appear as the owner.

f. Click OK.
Microsoft Word opens for you to create the new template.

4. In the empty document, type the text you want to include in the proposal template.

5. To add Infor CRM merge fields to the template, place the cursor in the template where you want the merge field
to appear, click Insert SLX Field, then from the merge field list, select a field.
The new merge field appears in the template.

6. Click Save and Close.
The Pricing Proposal appears in the Private Templates folder under the E-mail family.

7. In the Manage Templates dialog box, click Close.

Using Mail Merge
You can use Mail Merge when you need to correspond with a group of contacts, accounts, opportunities, or leads. Mail
Merge helps you simplify the process of sending the same information to numerous people by merging information into
a template. You can merge to a file, send an e-mail, send a fax, or print the merged document.

Our scenario:
You recently provided a demonstration for upgrading all of your contacts at Beeker Motors, and want to send a
letter thanking them for their time. You want to run a mail merge to send the information to all contacts at once.

To send e-mail using Mail Merge

1. On theWrite menu, click Mail Merge.
The Mail Merge dialog box appears.

2. In the Template box, click the Open button, expand the Public Templates list, expand the E-mail list, and then
double-click the Thank you - Demo template.

3. In the Merge With area, select  Specific, select Account, and the click the Find button.

4. In the Lookup, type Be, click the Find button, and then double-click Beeker Motors in the list.

5. In the Output To area, select E-mail.

6. In the From box, your name appears.



7. (Optional) Click the Address Book in the CC and BCC boxes to select any other recipients.

8. In the Format box, the default format of your selected template is shown; select another format if desired.

9. Click the History Options tab.

10. Make sure the Add History record for each Contact option is selected.

11. In the Category box, click the ellipsis button, select Demo, and then click OK.

12. Click Merge.
The merged e-mails are sent to all recipients and history records are added for both contacts.

For more information see the "Using Mail Merge" topic in the Infor CRMWindows
Client Help.

Using Outlook Integration
If your company uses Outlook Integration, you can save Outlook e-mail messages as Infor CRM history items. For
example, you can:

n Compose an e-mail message in Outlook, select contacts from the Infor CRM Address Book, and then click Send to
CRM to record the e-mail body and any attachments to the associated record. You can also include attachments to
the message.

n Select an e-mail message in Outlook, and then click Record to History to record the e-mail body and any
attachments to the associated record.

n Send an Infor CRM contact's information in a vCard file format via e-mail.

n Attach documents from Infor CRM Library to a message in Outlook.

n Add Infor CRM contacts to Outlook and synchronize changes made in Infor CRM to Outlook. For more information,
see "Adding a Contact to Outlook" in the Sales Client Help.

n When working with an Infor CRM contact in Outlook, you can click the Go to CRM button to open the contact's detail
view in the Infor CRM Client.

n Drag and drop e-mail messages from Outlook to the Infor CRM History tab.

n Click the E-mail button on the Ticket Detail view to copy ticket information into a new e-mail message, and then
click Send to CRM in Microsoft Outlook to send the message and save it to Infor CRM.

For more information see the following topics in the Infor CRMWindows Client Help:

n "Sending an E-mail Message from a Ticket"

n "Understanding Calendar Integration"

n "Understanding Contact Integration"

n "Understanding E-mail Integration"
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Our scenario:
You want to send an e-mail to Tom Dale and Joan Smith of Beeker Motors to tell them that you will be out of the
office for a few days. You can use Microsoft Outlook and record the e-mail message in Infor CRM.

To send an e-mail to multiple records using Outlook Integration

1. On the Navigation Bar, click Contacts.

2. Use the Lookup to find the contacts you want to e-mail.

a. On the Lookupmenu, point to Contacts, and then click Company.

b. In the second box type be, and then click Find.

c. Select Create a temporary group containing all results, and then click OK.

3. Click the List/Detail button to open to Contacts List view.

4. Select Tom Dale and Joan Smith.
To select more than one record, hold down [Ctrl] or [Shift], and highlight the records.

5. Right-click and selectWrite E-Mail to Selected Records.

6. If the Select Names dialog box opens, select both names and click the To button, and then click OK.

7. If e-mail is enabled, but you have not logged on, at the message box, click Yes to log on.

8. In the Subject line, type Out of Office.

9. In the Body area, type I will be out of the office for a few days. I’ll contact you when I return.
Since you are using Outlook to send this e-mail message, you may want to record this to Infor CRM History.

10. Click the Send to CRM button.
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Chapter 5
Managing Opportunities for Sales

Opportunities are potential sales to accounts and contacts. As an opportunity progresses, you can track the products
involved in the opportunity, days in the pipeline, competitors, level of commitment by the prospect, and much more.

In this chapter, you will learn to:

n Add an opportunity

n Use Opportunity Statistics

n Close an opportunity

Adding a New Opportunity
Use the Insert Opportunity dialog box to enter opportunity information and to add, edit, or remove products, competitors,
or contacts. You can also update the opportunity currency and rate if you have Multi-Currency enabled. You cannot add
an opportunity to a personal account.

If you frequently use the same settings when adding opportunities, you can set
default values. For more information see the "Setting Opportunity Defaults" topic in
the Infor CRMWindows Client Help.

It is not necessary to complete all information when you add an opportunity. You can add the information that is most
important to your company when you add the opportunity, and then update the Opportunity Detail view with more
information later. For example, when you add an opportunity, you may want to note the probability of closing the sale,
the dollar amount, and the estimated close date. Then add information as the opportunity moves through the pipeline.

n If you do not want to add products while adding a new opportunity, you can add them later using the Products tab in
the Opportunity Detail view.

n Adding contacts to an opportunity allows you to target the individuals at the account and designate their roles and
influence in the possible sale. If you do not add contacts while adding the new opportunity, you can add them later
using the Contacts tab in the Opportunity Detail view.

Our scenario:
There is an opportunity for a sale of 10 printers to Beeker Motors. You want to create a new opportunity and add
products and contacts.

To add a new opportunity

1. Open the Beeker Motors' Account Detail view.

2. On the Insert menu, click Opportunity
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3. Complete the following information:
Based on your Opportunities options, some boxes may already be completed.

n Description - Enter a name for the opportunity.
To help track opportunities, use the account name in the opportunity description.

n Account - Verify that Beeker Motors appears.

n Acct. Mgr. - Click the Find button to find the person or team within your organization that manages the
account.

n Est. Close - Click the Calendar button, select the date that the opportunity is estimated to close, and then
click OK.

n Status - Your company defines the opportunity status list. Click the ellipsis button, and select a status
from the list.

n Type - Click the ellipsis button, and select New.

n Source - Click the Find button, and select Trade Show.

n Close Prob. - Click the ellipsis button, and then select the probability that this opportunity will be closed
from the list.

4. Add the opportunity products.

a. In the Products section, click the Add button.

b. From the Add Opportunity Product dialog box, find and select NetPrinter Laser Elite in the Available
Products list, click Add, and then click OK.

c. In the grid, click the Quantity column and change 1 to 10.

5. Add the opportunity contacts.

a. In the Contacts section, click the Add button.

b. From the Select Contact(s) dialog box, select Joan Smith, and then click OK.

6. Click OK.

Using Opportunity Statistics
You can use Opportunity Statistics to view opportunity information at a glance. You can view opportunity statistics for a
group of opportunities, or you can select individual opportunities from the Opportunity List view. You can also export
opportunities to Excel or view opportunity reports.

To open Opportunity Statistics

1. On the Navigation Bar, click the Opportunities button.

2. In the Opportunities List view, open the group of opportunities you want to view.
You can get statistics for the entire group or select multiple opportunities in the Opportunity List view.

3. Do one of the following:

n On the Viewmenu, click Opportunity Statistics.

n Select the record(s) you want to view, right-click in the list view, and then click Statistics for Selected
Opportunities.

4. When finished, click Close.

To export opportunities to Excel
l Click the Export Group button.
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Closing an Opportunity
When an opportunity is won or lost, you should close the opportunity. For future reference and reporting purposes, you
should provide the reason for closing the opportunity.

Our scenario:
Beeker Motors has agreed to your terms and pricing and now you may close the opportunity.

To close an opportunity

1. Open the Beeker Motor's opportunity in the Opportunity Detail view.

2. In the Status box, click the ellipsis button, select Closed-Won from the list, and then click OK.
The Close Opportunity dialog box opens.

3. If necessary, modify the Actual Close date. To modify the date, click the Calendar button, select a new date, and
then click OK.

4. In the ReasonWon box, click the ellipsis button, select an item or items from the list, and then click OK.

5. In the Comments box, type Delivery must be complete by the end of the financial quarter.

6. Click OK.
Beeker Motors’ Opportunity Detail view appears with a Closed-Won Status and the Probability automatically
updates to 100%.

7. The Move Products to Assets dialog box opens, click OK to move the printers from opportunity products to
assets.

To assign a serial number to an asset

1. Click the Beeker Motors link.

2. Click the Assets tab. If the tab is not visible, click the More Tabs tab.

3. Double-click NetPrinter Laser Elite.
The Edit Asset dialog box opens.

4. In the Serial Number box, type BMNPLE001.

5. Click OK.
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Chapter 6
Managing Leads and Campaigns

This chapter is an introduction to Infor CRM Marketing. With Infor CRM Marketing you can develop and qualify new sales
leads, convert leads in into customer in a structures process, and create and manage sales campaigns while tracking
their effectiveness.

In this chapter, you will learn to:

n Add leads to Infor CRM

n Import leads to Infor CRM

n Qualify a lead

n Add a campaign

n Add targets to a campaign

n Add stages and tasks to a campaign

n Add products to a campaign

n Launch a campaign

n Track campaign responses

Working with Leads
Leads are unqualified potential customers. Use lead qualification criteria to determine if a lead has valid information,
already exists as a lead or contact, or is ready to be converted to a sales opportunity. Once qualified, a lead can be
converted to or merged with a contact and account. You can also create a new sales opportunity.

Adding a Lead
There are many ways in which your company can acquire leads. They may buy lead lists, acquire another company’s
customers, or find a single lead while maintaining current accounts. If you have multiple leads, importing the information
to Infor CRM is the most efficient method. However, if you cannot import lead information, you must manually add the
lead(s) to Infor CRM.

Our scenario:
While you were speaking to a current contact, he mentioned his friend Bob Green may be interested in purchasing
some software. You need to add Bob Green to Infor CRM as an unqualified lead.

To add

1. On the Insert menu, click Lead.

2. In the Name box, type Bob Green.
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3. In the Company box, type Green Dentistry.

4. In the E-mail box, type bob.green@greendentist.mail.

5. In the Phone box, type 5553211234.

6. Click Look for Matching Records to search the database for leads, contacts and accounts that have matching
information.
The Matching Leads dialog box appears. If a matching record displays in this dialog box, you can open the
matching record to see if the lead, contact, or account is the same as the lead you are entering.

7. In the Matching Leads dialog box, click Close.

8. In the Title box, select or type Managing Director.

9. In the Industry box, click within the box, click the ellipsis button, select Healthcare/Medical/Pharmaceutical,
and then click OK.

10. In the Interested in box, type accounting software.

11. In the Lead Source box, click the Find button.

12. In the Lookup Lead Source dialog box, click the Find button, selectWord of Mouth/Referral, and then click OK.

13. In the Insert Lead dialog box, click OK.

Importing Leads
Your company may purchase mailing lists or have a large number of potential customers that must be tracked in Infor
CRM. Rather than adding leads one at a time, you can import large numbers of leads to Infor CRM quickly and easily.

Use the Import Leads view to import lists of leads into Infor CRM. You may only import leads from a comma-separated-
values (CSV) list. Valid file types include Microsoft Excel, .txt files, and other database file types, but files must be saved
as a CSV file.

Chapter 6 Managing Leads and Campaigns
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Our scenario:
Your manager has given you a file containing 200 leads. You want to import the leads into Infor CRM so that you
can begin calling them.

To import leads

1. From the Insert menu, click Import Leads.

2. Click the Lead List File Open button, browse to the list you want to import, and then click Open.
The Import Leads Preview dialog box opens.

3. Preview the records before they are imported. If necessary, select a different delimiter value, for example a
comma, semicolon, or text qualifier.

For more information see the “Import Leads Preview” topic in the Infor CRM
Windows Client Help.

4. Click OK.
The wizard moves to Step 3, Map Fields.

5. Match the lead list fields and Infor CRM lead fields. If you want to display all of the fields in both lists and any
template, select Show All Fields.

a. In the Match this field from the list box, select the external list field you want to match. If you need to
preview the imported list, click Preview.

b. In the with this field in Saleslogix box, select the Infor CRM field that the list field should be matched with.

c. Click Match.
Matched fields display in the Matching Fields box.

6. Repeat the previous step for each field that needs to be matched.

7. Click the Default Owner Find button to select the person or team within your organization that will own the
imported leads.

8. Click the Default Lead Source Find button to select how the imported leads were generated.

9. Click Import.

Qualifying a Lead
A lead may contain unqualified information. You can use lead qualification criteria to validate information and determine
if the lead is a sales opportunity. Once qualified, you can convert a lead to a contact and account and create a new sales
opportunity.

Our scenario:
You spoke to Bob Green on the phone and he has decided to order from your company. You need to add the
information regarding Bob’s purchase and convert him to a qualified lead.

If your Qualification criteria was customized by your administrator, the items you see
in your workspace may be different.

To qualify a lead

1. Click the Leads button on the Navigation bar.

2. Click the Leads Quick Find button (magnifying glass).

3. In the Find dialog box, type green, click the Find button, and then double-click Green, Bob in the list.

4. In the Qualification box, click the drop-down arrow, and then click Lead.



5. Under Qualification:

a. Select the Valid Contact check box.

b. Select the Budget for purchase check box, and then in the corresponding text box type 5000.

c. Select the Timeframe for purchase check box, and then in the corresponding text box type 3 months.

d. Select the Business need identified check box, and then in the corresponding text box type accounting
software.

e. Select the Decision maker identified check box, and then in the corresponding text box type Bob Green.

6. Once the lead is qualified and ready to convert to a contact and account, click the Convert Qualified Lead button.

7. In the Convert Lead dialog box, verify that no existing contacts or accounts match the lead you are qualifying.

8. Click Convert.

Working with Campaigns
A campaign is a combination of various advertising, public relations, sales promotion, and selling activities used over a
period of time to achieve predetermined sales or marketing goals. A campaign can target a specific industry or group.
Infor CRM Marketing allows you to track information such as the time frame of the campaign, products associated with
the campaign, response rates for a campaign, and more.

Adding a Campaign
After you have determined what type of campaign your company plans to use, you can add the information to Infor CRM.

Our scenario:
Your company has decided to run a return mail advertisement campaign to all leads and contacts in the state of
Illinois. You need to add the campaign information to Infor CRM. This includes the campaign targets, stages, and
tasks that must be completed during the campaign.

To add a campaign

1. On the Insert menu, click Campaign.
The Insert Campaign dialog box appears.

2. In the Campaign Name box, type IL Return Mail Ad Q4 FY2015.

3. In the Description box, type Return mail advertisement for IL - Fall 2015.

4. In the Objective box, type Promote PC v7.
In this scenario, the objective of the campaign is to promote the new version of Pocket PC.

5. In the Call to Action box, type Pre-register and save 10%.

6. In the Lead Source box, click the ellipsis button, select Advertising - General, click Add, and then click OK.

7. In the Products box, click the ellipsis button, type Po in the filter box, click the Find button, select Pocket PC,
click Add, and then click OK.

8. In the Status box, select Setup.

9. In the Code box, type RMAdQ42015.
The code is a unique identifier for this campaign.

10. In the Start Date box, type or select next Monday’s date.

11. In the End Date box, select a date 3 months in the future.

12. In the Manager box, click the Find button, select your name, and then click OK.
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13. Click OK.
You can add targets, stages, and tasks using the Insert Campaign dialog box. However, the steps in the following
sections describe how to add these records after the campaign has been added to Infor CRM.

Adding Targets to a Campaign
When you identify your targets, you isolate the contacts, accounts, and/or leads on which to focus your marketing efforts.
Effectively targeting your audience allows you to make the most of your marketing campaign by spending time and
money on a segment of the market most likely to purchase from your company.

To add targets to a campaign

1. On the Navigation Bar, click Campaigns.

2. Open the IL Return Mail Ad Q1 FY2015 campaign in the Campaign Detail view.

3. Click the Targets tab.

4. Click the Manage List button.

5. Use the filters to narrow the list of records.

a. Select Accounts (all Contacts).

b. Select the State check box, select Starting with in the drop-down box, and then type IL in the text box.

6. To find out how many targets meet the filter criteria before searching, click the HowMany? button. After viewing
the number of targets, click to OK to close.

7. Click the Add Targets button to add all the targets in the list and close the dialog box.
The targets appear in the Targets tab grid.

8. Click OK.

When you leave and return to the Targets tab, you may need to click Refresh
in order to see the list of targets.

Adding Campaign Stages and Tasks

To add a stage to a campaign

1. Open the IL Return Mail Ad Q4 FY2015 campaign in the Campaign Detail view.

2. Click the Stages/Tasks tab.

3. Right-click within the Stages/Tasks tab, and then click Add Stage.
The Add Stage dialog box appears.

4. In the Description box, type Prepare ad slick.

5. In the Status box, click the ellipsis button, and select In Progress.

6. In the Comments box, type Used in-house ad department. Updated campaign previously targeted to state of
CA.

7. In the Start Date box, select today’s date.

8. In the End Date box, select a date one week from today.

Campaign tasks can help Infor CRM Marketing users manage their campaigns. You can add and edit task information,
or complete a task once it is finished.



To add tasks to a campaign

1. In the Add Stage dialog box, click Add Task.

2. In the Description box, type Update CA ad slick from FY2011 Q4 campaign.

3. In the Status box, click the ellipsis button and select Completed.

4. In the % Complete box, type 100.

5. In the Needed Date box, select yesterday's date.

6. In the Assign to section, selectOther Individual.

7. In the Assign To box, type Advertising Dept - Tom.

8. Click OK.

9. In the Add Stage dialog box, click Add Task.

10. In the Description box, type Print new ad slick.

11. In the Status box, click the ellipsis button, and then select In Progress.

12. In the Needed Date, select a date 6 days from today.

13. In the Assign to section, selectOther Individual.

14. In the Assign To box, type Print Vendor.

15. Click OK.

16. Click OK.

Adding Products to a Campaign
Products are the goods and/or services that you are selling in a campaign. You can add products to a campaign when
you add the campaign information to Infor CRM, or you can add or change product information for an existing campaign.

Our scenario:
Management wants to add an additional incentive for the campaign. You need to add additional products to the
direct mail campaign.

To add products to an existing campaign

1. Open the IL Return Mail Ad Q1 FY2015 campaign in the Campaign Detail view.

2. In the Products box, click the ellipsis button.

3. In the Add Campaign Product dialog box, click the Find button.

4. In the Available Products list, selectGoStore 200GB and Kiva Big Mouth Briefcase, click Add, and then click
OK.

Launching a Campaign
When all campaign information has been added to Infor CRM, you are ready to launch the campaign. Launching the
campaign allows Infor CRM to begin tracking information used in reports, budgets, and so on.

When a campaign is launched, the campaign target contacts and leads are assigned to the first stage of a campaign and
their status is changed to "Launched".
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Our scenario:
After verifying all the campaign steps and information, you want to launch the campaign.

To launch a campaign

1. Open the IL Return Mail Ad Q1 FY2015 campaign in the Campaign Detail view.

2. Verify all the information is correct.

3. Click Launch.

4. Review the Launch Summary report.

5. Click Close when finished.

Tracking Campaign Responses
After you launch a campaign, you can begin to track the responses associated with the campaign. Campaign responses
include who responded, the date, the response method, any notes, and so on. You can track responses during various
stages of the campaign. Adding this information correctly helps your company to identify successful campaigns and
stages to aid in refining and running successful campaigns in the future.

Campaign responses can be added and viewed in the Infor CRMWindows Client Client.

Our scenario:
You need to add a response for a recent campaign. The individual has decided to purchase from your company.

To add and view campaign responses

1. Open the IL Return Mail Ad Q1 FY2015 campaign in the Campaign Detail view.

2. Click the Responses tab.

3. Right-click within the Responses tab, and then click Add Response.

4. Select Contact, click the Contact Find button, type st, click the Find button, select the first name in the list, and
then click OK.

5. Click the Response Methodellipsis button and select Phone.

6. In the Comments box, type Responded within 5 days. Qualifies for 10% discount and free carrying case.

7. Click OK.
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Chapter 7
Working with Customer Service and Support

This chapter introduces you to the Infor CRM Customer Service and Support features. The Customer Service and
Support features allow designated users to track, qualify, and resolve customer questions and issues.

In this chapter, you will learn how to:

n Understand and work with contracts

n Add, work in, and close tickets

n Add and close a return

n Add and close a defect

Working with Contracts
Contracts are agreements between accounts and your company to provide support for products sold. Infor CRM has five
general types of contracts that cover support services. In addition, a contract can cover a specific set of products, or it can
be a “blanket” contract that covers all products the account owns. You can use contracts to verify that support should be
provided to specific accounts for specific products.

Understanding Contract Types
The five default contract types are:

Type Description
Days The contract is tracked according to a number of days of services the account has purchased. This

value is entered into the Quantity box for the contract. When the contract type is Days, and as
activities are generated for the account, the value in the Remaining box will not decrement.

Hours The contract is tracked according to a number of hours of services the account has purchased.
This value is entered in the Quantity box for the contract. The total time is calculated using the
Elapsed Hours value for all activities generated for the account. As activities are generated, the
value in the Remaining box decreases to reflect the number of hours left on the contract

Incidents The contract is tracked according to the number of service calls the account has purchased. This
value is entered into the Quantity box for the contract. The total number of incidents reflects the
total number of tickets the account has opened. As tickets are opened, the value in the Remaining
box decreases to reflect the number of incidents left on the contract.
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Type Description
Value The contract is tracked according to a currency value placed on the services the account has

purchased. This value is entered into the List Price or Contract Amount box for the contract. When
a ticket activity is created against the contract, the activity's Total value is charged against the
contract amount, and the value in the Remaining box decreases to reflect the value left on the
contract.

Perpetual The contract has no limit. The account can open an unlimited number of tickets and activities for
an unlimited amount of time.

To ensure that the time, number of incidents, or currency value left on a contract is tracked accurately, you must activate
the contract before beginning work on a ticket.

Adding a Contract
Each contract you add must be connected with an account that already exists in Infor CRM. The following scenario
explains how to create a contract for an account.

Our scenario:
Tom Dale calls to request a new contract. He wants a one year contract that covers up to 10 incidents.

To add a contract

1. Open the Beeker Motors Account Detail view and select the Contracts tab. If the tab is not visible, click the
More Tabs tab

2. Right-click in the grid and then click Insert New Contract.

3. Complete the contract information boxes.

a. Select Active.

b. Verify that Dale, Tom is listed in the Contact box. If not, click the Find button and select Tom Dale from the
lookup.

c. In the Comments box, type New 1 year contract for 10 incidents. Qualifies for new customer discount.

d. Click the Service ellipsis button and select Classic Care Ultra from the list.

e. Click the Contract Type ellipsis button and select Incidents from the list.

f. Leave the Start Date as today's date.

g. Click the Expiration Calendar button and select the date one year from today.

h. In the Quantity box, type 10. This specifies that the contract covers 10 incidents in the next year.

i. Type a purchase order number in the PO Number box.

j. In the List Price, type 500.00.

k. In the Discount box, type 50.00 because he qualifies for a new customer discount.
The Contract Amount is automatically calculated.

4. Click OK.

5.  Associate Beeker Motors assets to the contract.

a. On the Contract detail view, click the Covered Assets tab. If the tab is not visible, click the More Tabs tab.

b. Right-click in the grid and click Associate Asset.

c. In the lookup, in the box type BMNP, click the Find button, select BMNPLE001, and then click OK.
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Working with Tickets
Tickets are records of customer inquiries or complaints. They can contain the information necessary to report,
investigate, and close an inquiry or problem. Before you add a ticket, the account and contact must exist in Infor CRM.

Adding a Ticket

Our scenario:
Tom Dale at Beeker Motors called. He is having a problem with one of their printers and needs the problem
resolved by the end of the week. You need to create a ticket to work on the problem.

To add a ticket

1. Open Tom Dale’s Contact Detail view.

2. On the Insert menu, click Ticket.

3. In the Insert Ticket view, verify Beeker Motors appears in the Account box.

4. If the Insert New Ticket - Account Service Information dialog box is displayed, then select the contact for the
ticket from the list of available contacts. In this case, select Tom Dale.

5. If necessary, in the Contact box, click the Find button, and then select Tom Dale.

6. In the Contract box, click the Find button, use the Lookup Contract to select the contract you created in the
previous scenario, and then click OK.

7. In the Area box, click the Find button and in the Area list select Hardware.
Options available for Hardware appear in the Category list.

8. In the Category list, select Printer.

9. In the Issue list, select Power, and then click OK.

10. In the Source box, click the ellipsis button, select Phone, and then click OK.

11. In the Status box, click the ellipsis button, and then select In Process.

12. Click the Urgency Find button, click the Find button, selectMed-High, and then click OK.

13. In the Needed Date box, use the Calendar button to select a date at the end of the week.

14. Verify the Assigned To box lists your name. If necessary, click the Find button and select your name from the list.

15. In the Subject box, type a short summary of the problem.

16. In the Description box, press Shift+F9, and then type detailed information for the problem.

17. Under Comments, in the InternalOnly box, press Shift+F9, and then type additional information that is important
to the ticket.

18. Click OK.

Adding Ticket Activities
Ticket Activities are added through the Ticket Activities tab on the Ticket Detail view. Ticket Activities enable you to track
the time, the types of tasks, and any associated costs involved in resolving a ticket. Activities are recorded by activity type
and charge rate and are used for billing the customer against their service contracts. You can add your own ticket
activities at any time from the Ticket Activities tab.



Our scenario:
You told Tom Dale that you will research his problem and call him back. You need to add a ticket activity for the
research time.

To add a ticket activity

1. Open Tom Dale's ticket.

2. Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab.

3. Right-click in the tab area, and then click Insert New Activity.
The Insert New Ticket Activity dialog box opens.

4. In the Type box, click the ellipsis button, and then select Research.

5. In the Public Access box, click the ellipsis button and select 1-Customer.
This setting determines whether customers will be able to see the ticket activity using Infor CRM Customer Portal.

6. Verify that the User box displays your name. If not, click the Find button to locate your name or the name of the
individual who will be responsible for completing the activity.

7. Verify that the Start Date box displays the correct start date and time for the activity. If not, click the Calendar
button to specify the correct date and time.

8. Since you have not yet completed the activity, skip the End Date box. When you complete the activity, you will
use the Calendar button to select the date and time you finished working on the activity.
It is very important that you select accurate dates and times in both the Start Date and End Date boxes because
this information is used to calculate the Time Units, Elapsed Hours, Rate, and Total Labor.

9. (If necessary) In the Charge Type box, click the Find button, select No charge,and then click OK.
The charge type is the rate your company charges against the customer’s support contract for the work you
performed.

10. In the Comments box, type Research printer power issues.

11. Click OK..

For more information see the "Adding and Editing Ticket Activities" topic in the Infor CRMWindows
Client Help.

Punching In andOut of a Ticket
The Punch In and Punch Out function enables you to track the time spent assisting a customer for each ticket. When you
click the Punch In button on a ticket's detail view, Infor CRM begins timing the activity. When you are finished, you can
click Punch Out. Infor CRM stops timing the activity and adds an activity record to the Ticket Activities tab for the ticket.

When you use the Punch In/Punch Out feature in a ticket, a timed activity is
automatically created.

Our scenario:
Tom Dale calls with more information on his printer problem. You need to open the ticket and track the time you
spend talking to him and gathering information.

To punch in to and out of a ticket

1. From the Beeker Motors Account Detail view, click the Tickets tab, and double-click the ticket.

2. Click the Punch In button.
The button text changes to Punch Out, and Infor CRM begins recording time against the ticket activity.
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3. Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab

4. Right-click on the Timed activity to edit and then click Open Activity.

5. Enter the information from your conversation with Tom Dale in the Comments.

6. Click OK.

7. When you are finished working on the ticket, click Punch Out to stop tracking time on the ticket.

Closing a Ticket
The stage at which a ticket is closed and the person responsible for closing a ticket depend on your company’s
processes.

Our scenario:
You resolved the problem with Tom Dale’s printer and completed all follow-up activities. Now you want to close the
ticket.

To close a ticket

1. Open Tom Dale's ticket.

2. Ensure all ticket information is complete and accurate.

3. In the Status box, click the ellipsis button, and then select Closed.

4. If you are prompted to complete open activities for the ticket, do one of the following actions:

n Click Yes to automatically complete any open activities which belong to you and do not have an End
Date.

n Click No close the ticket, leaving the ticket activity without an End Date.

5. Click the Details tab and update the Resolution.

a. Press Shift+F9.

b. Type Printer overheats and turns off due to faulty fan.

6. If you want to submit the resolution information to be accepted into the SpeedSearch indexes, select the Submit
for SpeedSearch check box in the top pane.

7. Click Save.

Working with Returns
Returns are agreements to accept returned products from a customer for service, replacement, refund, or credit. This
may also be referred to as an RMA or Return Materials Authorization.

Adding a Return
Every return must be associated to a ticket. Before you add a return, ensure that the related ticket exists. If necessary,
create the ticket before proceeding.



Our scenario:
Tom Dale reported a problem with a printer and sent it in for repairs. After researching the ticket, you determined
that the printer must be replaced.

To add a return

1. Open Tom Dale's ticket.

2. Click the Returns tab. If the tab is not visible, click the More Tabs tab.

3. Right-click and click Insert New Return.

4. Verify that the Ticket ID, Account, and Contact are correct.

5. In the Reason box, type Printer overheats.

6. In the Customer PO box, type the customer purchase order.

7. Click the Status drop-down arrow and select Return Received.

8. Click the Type drop-down arrow and select Send Replacement.

9. Click the Priority drop-down arrow and select Next Day.

10. In the Expected By box, click the Calendar button, and select this Friday. Click OK.

11. Click OK.
The Return Detail view opens.

12. Click the Ship To Details tab. If the tab is not visible, click the More Tabs tab.

13. Verify the contact and address information is for Tom Dale at Beeker Motors.

Adding Products and Shipping Details to a Return
You add products to a Return to indicate which product the account is returning, and which is the replacement product to
be shipped to the customer.

Our scenario:
You added the return for Tom Dale's ticket and now want to add the product asset that Tom is returning.

To add an asset to a return

1. Open the detail view for the return you created for Tom Dale's printer.

2. Click the Return Details tab. If the tab is not visible, click the More Tabs tab.

3. Right-click in the Assets to Return grid, and click Associate Asset.

4. Locate and select the NetPrinter Laser Elite printer using the lookup. In the box type BMNP, click the Find
button, and select BMNPLE0001.

5. Click OK.

To update the shipping contact information

1. Click the Ship To Details tab. If the tab is not visible, click the More Tabs tab.

2. Verify that Tom Dale is the Contact.

3. Use the Ship Via and Tracking # boxes to include additional shipping information.

4. In the Attention box, type Tom Dale.
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5. Verify that the address information is correct.

6. Type any special shipping instruction in the Special Instructions box.

7. Click Save.

To add the products to be returned and replaced

1. Right-click in the Assets to Ship grid, and then click Add.

2. In the Insert New Shipped Product dialog box, under Returned Product, click the Product SKU Find button,
select NetPrinter Laser Elite printer, and then click OK.

3. Select Return Existing.
The returned product is automatically added.

4. Click the Shipped DateCalendar button and select today's date.

5. Click OK.

For more information see the "Using the Return Ship To Details Tab" topic in the Infor CRMWindows
Client Help.

Closing a Return
The stage at which a return is closed and the person responsible for closing the return depend on the process within
your company. As an example, when the product has been returned by the customer and the replacement product has
been shipped, that might be the stage at which you would close a return.

Our scenario:
Now that Tom Dale's replacement printer has been shipped to him, you want to close the return.

To close a return

1. Open the detail view for the return you created for Tom Dale's printer.

2. In the Status box, click the drop-down arrow, and then select Closed from the list.

3. Click Save.

Working with Defects
A defect is a record describing a problem in a product or process. It is similar to a ticket, but people involved in the
design or construction of the product typically resolve defects. The system tracks defects so that problems with a product
or process can be resolved in a timely manner, and company management is aware of issues with these products or
processes.



Adding a Defect to an Existing Ticket
When you discover a problem in a product or process, you can add a defect to Infor CRM.

Our scenario:
After receiving Tom Dale’s printer you discovered that there is a defect with the cooling fan. You need to enter a
defect to track the problem.

To add a defect to an existing ticket

1. Open Tom Dale's ticket.

2. Click the Defects tab. If the tab is not visible, click the More Tabs tab.

3. Right-click in the gird, and click Insert New Defect.

4. Click the Project ellipsis button and select Hardware. Click OK.

5. In the Version Found box, click the ellipsis button,and select 1.

6. In the Target Version, click the ellipsis button, and select 2.

7. In the Current Progress box, click the ellipsis button, and select Customer Return.

8. In the Area box, click the Find button and in the Area list select Hardware.

9. In the Category list, select Printer.

10. In the Issue list, select Power, and then click OK.

11. Leave the Status as Open.

12. In the Source box, click the ellipsis button, and select Parts.

13. In the Type box, click the ellipsis button, and select Power.

14. In the Priority and Severity boxes, click the ellipsis button, select the importance and impact of the issue.

15. In the Frequency box, click the ellipsis button,and selectWeekly.

16. Click the Assigned To Find button , select your name from the list, and then click OK.

17. In the Subject type Printer fan stops and printer overheats.

18. In the Description box, press Shift+F9, and then type Cooling fan stops which causes the printer to overheat
and turn off during a print job.

19. Click OK.

Closing a Defect
The stage at which a defect is closed and the person responsible for closing the defect depend on the process within
your company.

Our scenario:
The problem with the NetPrinter Laser Elite fan has been identified. You are ready to add a resolution and close
the defect.

To close

1. Open the defect you created for the NetPrinter Laser Elite.

2. In the Fixed in Version box, click the ellipsis button and select an item from the list.
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3. In the Status box, click the ellipsis button, and then select Closed. Click OK.

4. In the Resolution box, press Shift+F9, and then type Fan is too small. Any printers experiencing this problem
should be returned and the fan will be replaced.

5. Click Save.
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Chapter 8
Using Reporting and Analysis Tools

Infor CRM includes reporting and analysis tools that help you identify opportunities and evaluate sales effectiveness.

The Reports List view provides a list of pre-defined sample reports to enable you to view and analyze information in the
Infor CRM database. You can run reports related to Main views such as Contact, Account, Opportunity and so on. If you
prefer, you can modify the report to accommodate your business needs. The specific reports available to you are
determined by your system administrator.

The Infor CRM Dashboard is a tool set that allows you to display and interact with a variety of performance and analysis
information in a dashboard format. You can use the data provided to gain insight into organizational and individual
performance, discover root causes for performance issues, and then take the corrective actions or make strategic
decisions.

In this chapter, you will learn to:

n Run a report

n Create and save a report filter

n Understand the Sales Dashboard

n Adjust Content Set data

n Access Analysis Views and set filters

Using the Reports View
Reports enable you to view information about contacts, accounts, opportunities, tickets, and other related data.

The Reports view allows you to select from a list of available sample reports and apply filters to narrow the results. You
can only access reports that have been released to you by the system administrator. Reports can be released to you
personally, or to a team that you are a member of. When you view or print any report, only records you have access to
are included in the report.

Our scenario:
You want to run a report listing all the interactions you have had with your contacts.

To run a report

1. On the Navigation Bar, click Reports.

2. In the Select the type of report list, select Contact.

3. In the Select the name of the report list, select Contact Summary - Sample.

4. Next to Show Records that match, click Edit.

5. In the Conditions Match box, select All..

6. IIn the Match By list selectGroup, and then in the Table list, selectMy Contacts.
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7. Click the plus sign to add the condition.

8. In the Send the report output to box, select Preview.

9. Click Generate Report.

10. In the Enter Parameter Values dialog box, choose whether you would like to include notes and whether you
would like each contact to display on a separate page.

11. Click OK.

12. In the report preview you can:
l Use the tree view in the left pane to view specific pages in the report.
l Use the arrow buttons to move to the next, previous, first, and last pages.
l Print the report.
l Export the report to a variety of supported file formats.

For more information see the "Filtering Data in Reports" topic in the Infor CRM
Windows Client Help.

Working with the Sales Dashboard
The Sales Dashboard allows you to display and interact with a variety of performance and analysis tools in a dashboard
format. You can use the data in the dashboard to gain insight into organizational and individual performance—and to
discover root causes for performance issues—allowing you to make strategic decisions or to take corrective actions.
From the Sales Dashboard, you can interact directly with other functions in Infor CRM, such as completing activities and
displaying opportunity views.

Understanding Dashboard Features
The Sales Dashboard is divided into three sections: an activities area, a standard Infor CRM middle pane (a user-
defined area), and a tab area.

Activities Area - The activities area offers a view into your Infor CRM activities. This area shows your schedule for the
day, and your timeless and past-due activities. You can right-click on an item to open the original activity record for
editing or review, or to schedule new activities.

Middle Pane - The middle pane (also called the user-defined area) serves as an open view of the content set you use
most often. You can change the content set in this area depending on your specific needs, or close it to allow for more
space to expand the Activities or content set areas.

Content Sets - These are graphs and a grid that give you a simplified view of business performance. You can change
some of the data in content sets, and you can drill to an analysis view from most content sets.

To display the Sales Dashboard
l On the Navigation Bar, click Dashboards, and then click Sales Dashboard.
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Using the Activities Area
The activities are contains two sections:

n The Today's Schedule section shows your scheduled activities for the current day.

n The My Activities section shows your timeless and past due activities. You can right-click on any activity to open
and act on it, or to create new activities.

Using Content Sets
Content sets display performance data in both graph and grid formats. The emphasis in content sets is on the 'top five'
results for the data displayed.

n The data in the graphs represent the data in the grid. You control the data in the grid by selecting filter parameters
using drop-down menus above the grid. The grid will display the most significant five results for your filter
selections, plus an additional row that summarizes all the data not included in the top five. A grand total row at the
bottom of most grids calculates the results.

n The graphs reflect the grid data, When you adjust the filter parameters, the grid data changes automatically. The
graphs also change to reflect the new gird data.

n The size of the graphs and the grid can be changed by moving their borders.

Changing Content Set Parameters

You can change content set parameters to see how processes and people are performing over time. You can select
different aspects of a business process to examine, as well as select standard or custom time periods for comparison.

Our scenario:
You want to see the top performing account managers for the last 30 days and 90 days.

To view sales performance

1. On the Navigation Bar, click Dashboards, and then click Sales Dashboard.

2. Click the Sales tab.
The content set opens and displays the grid and graphs associated with the content set.

3. In the List By menu, select Account Manager.
The grid and graphs refresh.

4. In the Period box, select Last 30 Days.
The grid and graphs refresh. Note the Grand Total information at the bottom.

5. In the Period box, select Last 90 Days.
The grid and graphs refresh. Check the Grand Total information at the bottom to see if the information changed.

For more information see the "Using Contents Sets" topic in the Sales Dashboard Help.

Using Analysis Views
Analysis views display information similar to content sets, but they offer more options for filtering data. Analysis views are
opened by clicking links on content sets.



n Like a content set, the grid is the key to an analysis view.The graphs represent the data in the grids. You control the
data in the grid by using filters. A grand total row at the bottom of most grids calculates the results.

n You can select individual filter values from a variety of filter groups in order to precisely focus your search results.

n The size of the graphs and grid can be changed by moving their borders.

n Analysis view grid results can be exported to Microsoft Excel with a single mouse click.

Changing Analysis View Filters

Filtering allows you to focus on specific data. For example, if you select Last 30-days from the Period box, the database
returns results for the last 30 days only. You can further refine your results by drilling for more information.

Our scenario:
You want a detailed look at open opportunities in your company. Specifically you would like to know how much
potential revenue each account manager has in the prospect stage of the opportunity pipeline.

To open an analysis view

1. On the Navigation Bar, click Dashboards, and then click Sales Dashboard.

2. Click the Open Opportunities tab.

3. Click the first hyperlink in the Account Manager column.
This opens the Open Opportunities Analysis view window, with the Account Manager filter set to the parameter
you selected from the Open Opportunities content set.

4. Click Filter Options.
The filter pane opens with a list of filter items. Note that the Account Manager filter shows the account manager
you selected in the previous step.

5. Click Clear Filters in the filter options panel on the left side of the analysis view.
With the filter restriction removed, the grid and graphs refresh to display all available data for open opportunities.
List By is still set to Account Manager.

6. In the Value column, click ALL next to the Opportunity Stage filter.

7. Click the ellipsis button in the Value column.
The Add Edit Filter Values dialog box appears.

8. Select 1-Prospect. You can search for values using the scroll bar or by typing in the Find box to refine your
selection

9. When you are finished, click OK.
The sales potential for open opportunities in the prospect stage are listed by account manager in the grid and
graphs.

You can click Filter Options to hide the filter panel, which increases the viewable area for the grid and
graphs in the analysis view.

10. To print the analysis view, on the File menu, click Print Screen.

11. To export the grid data to Microsoft Excel, click Export to Excel.
An Excel workbook opens with all the grid columns and data represented. (Requires Microsoft Excel)

Only the number of rows displayed in the grid are exported. Use the Show Rows selector to display
additional rows if required.
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For more information see the "Selecting Filters in Analysis Views" topic in the Sales Dashboard Help.
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Chapter 9
Using Infor CRM Away from the Office

When you work outside the office, it is important that you are able to obtain up-to-date sales information for your
company. By using the Infor CRM Remote Client, you can have the tools to keep your information current with the
information at the main office.

In this chapter you will learn to:

n Synchronize your Remote database with the main office database

n Use What's New to track changes to your local database

n Subscribe to accounts

Understanding Synchronization
Synchronization is an exchange of files between remotes and the main office. The following examples demonstrate the
synchronization process.

n A Network user, working on a machine connected to your company's network, makes changes directly to the main
office database.

n A Remote user, working on a machine connected to your company's network, makes changes directly to the main
office database.

n Remote Office users make changes directly to the Remote Office database (as a Network user). The Remote Office
connects to the main office to drop off and retrieve files using the same process as Remote users.

n Synchronization uses the files delivered by the Remote users and offices to resolve any conflicts, apply Remote
user and office changes to the main office database, and then create files detailing changes for the Remote users
and offices.

Synchronizing with the Main Office Database
To keep your Remote Client database current with the main office, it is important to synchronize regularly. If you do not
synchronize every day or every other day, the databases with shared records (main office and Remote Clients) soon
become out of date. Frequent synchronization also helps reduce synchronization time since a smaller number of
transactions are processed.

Automatic Synchronization allows you to synchronize automatically when you first
connect to the main office, and periodically thereafter while still connected.
Automatic sync is enabled by default. To learn more, see the “Infor CRM
Synchronization Client” topic in the Infor CRM Client Help.
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To synchronize with the main office database

1. On the File menu, click Synchronize.

2. On the Automatic Sync tab, selectOn.

3. In the Sync runs when you first connect and then every boxes, set the time you want synchronization to occur.

4. Click the Sync Options tab.

5. To synchronize using a dial-up connection, select the Connect using RAS option, and then select your profile in
the RAS Profile list. Clear the Connect using RAS check box if your are connecting via a network connection.

6. Click Sync Now to begin the synchronization process.

7. When the synchronization is complete, click Close.

If errors occur during synchronization, contact your system administrator to resolve them.

Reviewing Synchronization Changes
After synchronizing, you can use What’s New to see the changes that were made to your database.

To view synchronization changes usingWhat's New

n On the Navigation Bar, clickWhat's New, and then click on of the options of the bottom of the window.

Click To check for
New New accounts, contacts, opportunities, activities,

notes, history, and documents.

Updated Accounts, contacts, opportunities, activities, notes,
and history you subscribe to that were changed by
other users.

Deleted Accounts, contacts, or opportunities deleted by other
users.

Understanding Conflict Resolution
Because records that reside on both the main office database and Remote databases can be inserted or changed
independently, a mechanism is needed to decide which changes are valid. The Conflict Resolution component of
synchronization decides which change wins.

The administrator can identify up to three criteria to determine which user wins when a conflict occurs.

Conflicts are resolved when changes are applied to the Network database, not the Remote database.
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Understanding Subscription
You can use subscription to select, or subscribe to, accounts you use on a regular basis and want to store on your local
database. Using subscription minimizes your database size and the time required to synchronize updated information to
the main office database. You and your system administrator can establish what accounts you need to subscribe to.

n You automatically subscribe to accounts you own as an individual or as a member of a team. You cannot
unsubscribe to these accounts.

n Other Infor CRM users that are added to your security profile (by the system administrator) can subscribe to the
accounts you own as an individual or as a member of a team.

Activity auto-subscription: If a user is assigned to an activity as a member, but the account is not in his or her
database, the user is automatically subscribed to the account. The exception is if the user does not have
access rights; in that case, the user receives notification of the activity, but is not subscribed to the account.

To subscribe to an account

1. On the Navigation Bar, clickWhat's New.

2. Click the Accounts tab.

3. Find the account you want to subscribe to,right-click, and then click Subscribe.
You will receive updated information for this account during synchronization.

To unsubscribe from an account

1. On the Navigation Bar, clickWhat's New.

2. Click the Accounts tab.

3. Find the account to which you no longer want to subscribe, right-click, and then click Unsubscribe.
You will no longer receive updated information for this account during synchronization.

For more information see the "What is Synchronization?" and "Subscription and Security" topics in the
Infor CRMWindows Client Help.
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